Facilitating online class using WebEx

Charina Ong

*Educational Technologist, CDTL*

charina.ong@nus.edu.sg
# Table of Contents

About the Workshop ................................................................................................................................... i  
Workshop Objectives ................................................................................................................................. i  
Session Prerequisites ................................................................................................................................. i  
Setting Up a Tutorial Session ................................................................................................................... 1  
  Scheduling an online session ................................................................................................................... 1  
Starting the Session .................................................................................................................................. 2  
  Getting Started ....................................................................................................................................... 2  
  Moving Around the Session Window ..................................................................................................... 3  
Facilitating an Online Session .................................................................................................................... 4  
  Understanding different roles ................................................................................................................. 4  
  Assigning Roles ...................................................................................................................................... 5  
  Assigning Attendee Privileges .............................................................................................................. 5  
  Transferring Host Role ........................................................................................................................... 6  
Sharing Content and Application ............................................................................................................... 7  
  Sharing a Document ............................................................................................................................... 7  
  Sharing an Application ............................................................................................................................ 8  
  Sharing the Whiteboard .......................................................................................................................... 8  
  Sharing Web Content ............................................................................................................................. 9  
Interacting with the participants online ............................................................................................... 9  
  Providing Feedback ............................................................................................................................... 9  
  Using Chat ........................................................................................................................................... 10  
  Using the Q&A ..................................................................................................................................... 11  
  Creating Polls ...................................................................................................................................... 12  
Ending a Tutorial Session ......................................................................................................................... 13  
Appendixes ............................................................................................................................................... 14  
  Updating your profile ............................................................................................................................ 14  
  Recording a session .............................................................................................................................. 14  
  Viewing a Recorded Video .................................................................................................................... 15  
  Converting WebEx Video to WMV ....................................................................................................... 15  
  Uploading Video to IVLE ...................................................................................................................... 15
About the Workshop

Have you considered using a tool that allows you to continue meeting and conducting your class while you are at a conference, urgent meeting, or a situation where you cannot physically meet your students? This session will introduce you to WebEx, a powerful Web conferencing application that allows you and your students to collaborate in a secure online environment. WebEx allows you to share documents and deliver presentations in real time using a Web browser and voice connection. The chat, Q&A, and poll features will definitely engage your students.

Workshop Objectives

By the end of this workshop, participants should be able to:

- Set up an online virtual class
- Deliver online presentation
- Share documents to students
- Use the communication tools to engage the students
- Use the poll feature to encourage participation

Session Prerequisites

In order to fully maximize the benefits of this workshop, participants are expected to have the following pre-requisite knowledge and skills:

- Basic computing skills
- Internet surfing skills
**Setting Up a Tutorial Session**

For most of your online sessions, it is advisable to schedule the session in advance to give you ample time to setup, prepare, and invite your students.

**Scheduling an online session**

1. Open your browser and type in [http://nus.webex.com](http://nus.webex.com) in the address bar.
2. Click **Host Login** located on the top right portion of your screen and enter the username and password provided by CIT.
3. Click **Host a session > Schedule Training**.
4. In the Session and Access information section, enter the required information.

5. In the **Audio Conference Settings**, please choose **Use VoIP only**.
6. Enter the date and time of class.
7. Click **Invite Attendees** and enter your particulars.
8. Click **Add Attendee**.
9. Your name will now appear on the Attendees list. Click on the box beside your name, and then click the **Invite** button.

10. This will lead you back to the Scheduling page. Scroll down and click **Schedule**.
Starting the Session

Getting Started

As the host, it is advisable to be in the virtual meeting room ahead of time. This allows you to prepare, so that you can start the class as soon as the students arrive. Please take note that the session does not automatically start at their scheduled time. The host or the instructor must be there to start.

To start a session:

1. You and your students will be receiving an email invitation with the URL, session number, and password. Click the link to start the session. It is suggested that you use Firefox Mozilla when holding online session.

   Hello Charina Ong,
   
   You scheduled the following training session:
   
   Topic: Online class 1
   Host: Charina Ong
   Date: Monday, May 27, 2013
   Time: 2:00 pm, Singapore Time (Singapore, GMT+08:00)
   Session Number: 861921223
   Session Password: please
   Host Key: 139900
   
   To start the session:
   
   2. Log in to your WebEx
   3. Click “Start Now”.
   4. Follow the instructions that appear on your screen.

2. Log-in your WebEx username and password.
3. In the Session Information page, click Start Now.
4. Cisco Training Center window appears on screen.
Moving Around the Session Window

The session window is the equivalent of a room where students and faculty come together to join a session. Participants can use different collaboration tools such as Share, Chat, Video, or they can simply be there to listen to the lecturer.

The session window is divided into several sections **Menu bar, Annotation toolbar, Content Viewer, Panels, and Viewing toolbar.**

- **The Content Viewer** takes the center stage in an online session. This is where participants share documents, presentations, whiteboards, and web content.

- **The Sharing** options on the Quick Start tab allow you to share a file, your desktop, or an application.
• Once you are sharing a document on a white board, the viewing and annotation tools become available. **Viewing tools** affect the display of your document or the white board, while the **annotation tools** allow you to draw content using various tools and you move forward and back on your presentation. The **Synch Display for All** button is also a useful feature. It ensures all participants are viewing the same page.

![View Tools and Annotation Tools](image)

• The **Panels** are located at the right side of the window to further interact with attendees. The host, panelist and attendees can collapse, minimize and manage their own panels.

![Panels Management](image)

**Facilitating an Online Session**

**Understanding different roles**

Roles in an online session include the **Host, Presenter, Panelists, and Attendees**.

• A **host** schedules the session, starts the session at the scheduled time, controls access to the session, designates panelists, and gives and takes the presenter’s role.

• A **presenter** is the instructor, who can share documents and presentations, whiteboards, application and web content; create and administer polls; answer questions; and set attendee privileges.

• A **panelist** is a subject matter expert, or in a classroom setup, you can assign a teaching assistant to be your panelist to assist you during the session. They can help you like answer students’ questions while you are conducting the lecture.

• **Attendees** refer to the student who will participate in the session. They can annotate, chat, ask questions, take a poll, and be given the presenter ball during presentation.
Assigning Roles

The host can change people’s roles anytime during the session. For example, a student has been asked by the instructor to present his work to the class, the instructor can temporarily assign him as the presenter.

To change a participant’s role:

1. Select the student name, and then in Participants panel, click Make Presenter. The student who has been assigned to be the presenter also becomes a panelist temporarily until the instructor takes back the presenter ball.

2. To take back the presenter role, right click on the instructor’s name, select Change Role to, and choose Presenter.

Assigning Attendee Privileges

As the presenter, you have the ability to grant certain privileges to the attendees. Privileges allow or deny specific function inside the session. Only the presenter can give or take privileges during the session. It is important to understand what your students can and cannot do during the session.

To assign attendee privileges:

1. From the Participants menu, select Assign Privileges. These privileges will be applied to all attendees in the session.
2. Select the privileges that you want to assign to your attendees, and then click OK.
**Transferring Host Role**

As a meeting host, you can transfer the host role to any participant anytime. By doing so, you are giving full control of the session to that participant. This option is useful when the instructor has an emergency meeting. The original host can reclaim the host role anytime.

**Tip:** A session ends if the host leaves without transferring the Host role. As the session Host, always remember to first transfer your role to another attendee before leaving.

To transfer the host role:

1. Click on the **Session Info** tab, and write down the host key so you can reclaim the host role later on.

   ![Session Info Image]

   - **Topic:** Online class 1
   - **Host:** Charina Li Ong
   - **Training session number:** 265-021-223
   - **Host key:** 139908

2. Right click on the participant’s name in the **Participants** panel, select **Change Role to** and choose **Host**.

To reclaim the host role:

1. From the **Participants** menu, choose **Reclaim Host Role**.
2. Enter the host key and click **OK**.

**Tip:** If you did not write down the Host key before transferring the Host role, ask the current host to send you the Host key in a private chat message.
Sharing Content and Application

Sharing a Document

A presenter may share a Word, Excel, PowerPoint, or PDF file to the viewers. Viewers will be able to see the document even if they do not have the program installed in their computer.

1. In the Quick Start tab, click **Share File** button. Click **Browse** to select the file you want to share, and click **Open**.
2. Your presentation is now loaded in the **Content viewer**. Attendees can view this file in real time.
3. To present the document in full screen mode, click the **full screen** button at the bottom of the screen.
4. Manage the presentation using the **Control** toolbar.
5. To stop the presentation and return to the meeting window, click the **Stop** button or press **ESC key**.
**Sharing an Application**

By sharing an application, participants view one or more application from your computer. This approach is good for doing demonstration.

**To share an application:**

1. Click the **Share application** icon.
2. The **Application Share** dialog box appears displaying all applications currently running in your computer.
3. If the application that you wish to share is not listed, click **Other Application**.
4. Choose a program that you want to share, and click **Share**.
5. To pass remote control, click the control panel, then click on the **Assign** button, and then select **Pass keyboard and mouse control**.
6. Select a participant’s name from the list and then click **Allow**. The participant you have selected takes control of the application by using their mouse.
7. To regain the control of the application, simply click your mouse button.
8. To stop application sharing, click **Stop** button in the **Control** panel.

**Sharing the Whiteboard**

The whiteboard allows the instructor to illustrate concepts or equations as if you are in an actual classroom. Students may annotate in the whiteboard using the drawing tools if the instructor enabled this privilege.

**To share a whiteboard:**

1. Click the **Share Whiteboard** icon.
2. Use the **annotation tools** to draw directly on the whiteboard. Participants will see all the things that you write or draw. If you have allowed annotation privileges for your participants, then they will be able to collaborate at the same time on the shared whiteboard.
Sharing Web Content

As a presenter, you may also share a webpage allowing attendees to navigate independently. For example, you can share an interactive website with your students. They can navigate around that page as the faculty discusses the lecture.

To share web content:

1. From the Share menu, click Share Web Content.
2. Enter the web address, and click OK.
3. The web page is now displayed on the content viewer.

Interacting with the participants online

Providing Feedback

On the Participants panel, the toolbar allows participants to provide non-verbal feedback without interrupting the flow of the discussion.
• Use the **hand** icon to raise a question. The icon appears beside the participant’s name to let the instructor know that student would like to speak.

• Use the **Yes or No** buttons to answer a question by the instructor.

• Use **Faster/Slower** to tell the instructor to move the lesson slower or faster.

> **Tip:** All students can see when someone raises hand, or use the Yes/No buttons and emoticons. However, only the instructor can view if someone clicks Go faster/slower.

• Use the **eraser** icon to clear the current responses before asking a new question.

**Using Chat**

Students can make public chat that maybe read by the entire class. They can also send a private message to the instructor or one attendee at a time, provided that the instructor has granted this privilege.

**To specify chat privileges:**

1. From the **Participant** menu, select **Assign Privileges**.
2. In the **Communicate** tab, under the **Chat with** option, select all the boxes, and click **Assign**. This allows any participant to chat with the host and all other participants.
To send a chat message:

1. Click the chat icon in the Panel tray.
2. Type the message in the box.
3. From the Send to list, select to whom you would like to send this message, and click Send.
4. To save the chat, go to File > Save > Chat.
5. Enter a file name and locate where you want to store this file in your computer, and click Save.

Using the Q&A

The Q&A panel holds questions in a queue, allowing the instructors or panelists to answer questions in any order without losing the thread or type of conversation. Students can see each other’s questions until public answer is posted. This is especially useful in a large session where teaching assistants can help answer questions while the instructor conducts the presentation.

To post a question:

1. Student will type his/her question in the box provided and then click Send.
2. There will be a question mark icon appearing beside the student’s name.

To answer a question:

1. The teacher or teaching assistant will be prompted whenever there is a question coming from the participants.
2. To reply to a question, select the question first before type the answer and then click Send.
3. The teacher can opt to answer the question verbally or send an answer privately. Sending private answer is useful when you want to defer the question until later or to politely dismiss the question if the concern is outside the scope of the class.
4. You may also send a standard customized reply.
Creating Polls

Polls allow you to gather feedback, take a vote or test knowledge. It provides instant result that you can share with all participants.

To create a poll question:

1. Open the Polling Panel, and choose a question type. For this example, we will use Multiple Choice.
2. Select an answer type. When you select multiple answers, participants can select all options, while single answer forces the participant to choose only one from the given options.
3. To add a question, click New, and type the question in the panel.
4. Click Add to enter each answer. The answers are ordered alphabetically.

5. To edit a question, double click on the existing question and make necessary changes.
6. You may also change the question type. Select the question you wish to edit, select a new question type, and click Change Type.
7. You can also send instructions to indicate that poll will be automatically closed at a designated time. Click Options and select the Display option.
8. Enter the poll duration, and then click OK.

9. To save the poll for later use, click the Save icon in the Poll panel.
10. Specify a location where you want to store your file, provide a name, and click Save.
Ending a Tutorial Session

One of the challenges in a traditional face-to-face class is to capture spontaneous feedback among students and to compile it as an attachment. The WebEx tools allow you to record and share meeting information such as using the Poll, Chat, Notes, Annotated Documents, etc. in different formats, which you can send out at the end of the session. The host/teacher is mainly responsible to end the session.

To end the session:

1. Click File menu, and choose **End Training Session**.
2. A confirmation window appears that the session will be ended. Click **Yes**.
3. The system automatically prompts you to save meeting files. Click the items that you wish to save.
4. Choose a directory where you want to save the files, and then click **Yes**.

5. A transcript will be sent to all participants. Verify the list of participants, and click **Send**. Participants will immediately receive a message with all the details of the session.
Appendixes

**Updating your profile**

2. From the top menu, click Host Log-in.
3. Enter the username and password provided by CIT.
4. To change your password, click My Webex from the top menu.
5. Click My Profile on the left navigation.
6. Click change password.
7. Enter your old and new password, and click Submit.

**Recording a session**

You may opt to record an online session. This will help students to keep track of the lesson even they missed. Faculty can save a copy of this recorded session in their personal computer and upload it in IVLE for class use.

**To choose where to save the video recordings:**

1. From the Session menu, click Recording Settings, and specify whether you want the video/s to be saved locally or remotely.

Make sure the Record Audio from this Computer is selected

**To record a session:**

1. On the Quick Start tab, click Record this Session.

2. Choose a directory where you want to save the file, enter a file name using this format: *Sem#_Modulecode_date*, and then click Save.
3. In the Recorder Panel, click the Record button to start the recording. All the shared documents, audio, video, chat discussion, poll survey, etc. will be captured.
4. The **status bar** will notify the students when the session is being recorded. Click the **Pause** button to temporarily stop and click the **Stop** button to end the recording.

![Recording Status Bar](image)

**Viewing a Recorded Video**

To install WebEx Recorder and Player:

1. Open your browser and type in [http://nus.webex.com](http://nus.webex.com) in the address bar.
2. **Sign in** as a host by clicking the **Host Login** button.
3. Click **Support>Downloads>Recorder and Player**.
4. Choose a platform whether Windows or Mac.
5. Save the file in your local disk.
6. When downloading is complete, double click the exe file and click **Run**.

To view a recorded session:

1. Double click the .wrf file to preview.

**Converting WebEx Video to WMV**

Same as the Player, you also need to install the **WebEx Recording Editor**. This allows you to convert the WRF to a compressed video file, which you will need later on when uploading it to your IVLE module.

To convert WebEx video to WMV:

1. Open the **WebEx Recording Editor** application and locate the wrf file.
2. From the **File** menu, select **Export to**.
3. Choose a directory where you want to save your file, provide a name, and then click **Save**.
4. Specify the movie settings, and then click **OK**.

**Uploading Video to IVLE**

1. Log-in to your module in IVLE.
2. Go to **Tools> Multimedia**, and click **Create Multimedia**.
3. Type in a title under **Multimedia Title**, and then click **Create**.
4. Click **Media**, and then **Upload**.
5. In the **Media option**, select **File**.
6. In the **Media Type** option, select **Video** and then click **Browse** to locate the file.
7. Select a folder where to upload the file, and then click **Apply**.
8. Set the **Publish settings** to **Yes** so that students will be able to view the file.
9. A shortcut link will automatically be available on the module workspace. Students will be informed that if there is a file uploaded as soon as they logged-in.